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Introducing Source-Live 3.0
Source-Live is a software application that allows you to stream your audio, DAW or NLE
mix to multiple listeners simultaneously along with an HD video representation of your
video screen or live video input. Unlike other video and audio broadcast software
applications, Source-Live is designed from the ground-up for the media industry for
broadcast where input streams may not be coming from the same source. You can
delay the audio in relation to the video input to ensure accurate sync is achieved, so
your listener can review and approve your content with satisfaction. Utilizing the most
current AAC/MP4 encoding, Source-Live provides listeners with true 24-bit audio
quality. Real-time “listener management” and industry-strength password protection
within the Source-Live application allows you to control who is listening in on your
session.

Source-Live 3.0 integrates directly into DAWs such as Pro Tools, Nuendo, Logic and
many more applications that support AAX, RTAS, Audio Units and VST plug-ins. It also
works well with NLEs such as Media Composer, Final Cut and Premiere. You simply
e-mail your listeners your Gateway link to your listeners who immediately connect to the
stream in real time from anywhere in the world. Source-Live additionally supports
common media player software such as Quicktime and VLC, and we offer a free iPhone
and iPad app called the “Source-Live Gateway” that is available on the Apple App
Store.
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System Requirements for Source-Live 3.0
​​Source-Live is a standalone application, and does not require additional software for
basic operation. Direct integration to your DAW mix is possible by using the Source-Live
Link plug-ins for AAX, Audio Units, VST and RTAS. Source-Live is “copy protected”
using PACE iLok however no iLok is required, although you will need an iLok.com
account and allow Machine Authorization.

Minimum recommended configurations

● OSX 10.8 (“Mountain Lion”)
● 2 GHz Intel Core i7, 8GB RAM
● 1MB Internet upload or higher

Source-Live Pro 3.0 is capable of HD video compression and therefore requires a
modern CPU with sufficient RAM. The CPU meter will indicate if your system is capable
of video processing.

For HD video broadcast, you will need excellent Internet upload capabilities of at least
1MB dedicated upload. We recommend connecting over Ethernet for best performance.

Source Elements © 2005-2022 - ONLINE GUIDE VERSION

https://ilok.com/


Source-Live 3.0 Compatibility

Mac OSX support:

Version 3.0 is compatible with Mac OSX version 10.8 and up.

Windows support: legacy only

Source-Live 1.2 will not support version of Pro Tools higher than 10.3 on Windows, and
it will only support 32-bit VST hosts. Please use the Mac OSX version if you need AAX
or 64-bit support.

Network Requirements

See Network Guide

Supported modems and routers.

Plug-In Type:

AAX / RTAS / AudioUnits and VST

Mac OSX

Supported configurations for Source-Live 3:

● OSX 10.8 and up
● Legacy support only for 10.6 and 10.7
● This application is not compatible with 10.7 or lower

○ Any DAW via Source-Link or direct routing
○ Any VST 2.3 compatible host
○ Any Audio Units compatible host (supports 64-bit sessions)
○ Minimum computer requirements: G4 1ghz, 1GB RAM

Windows

Support configuration for Source-Live 1.2:Note: Source-Live for Windows is no longer
being updated

● Windows XP and Windows 7 support only
● Pro Tools 7 - 10.3 support only
● 32-bit hosts only on VST
● This application is not Vista compatible
● This application does not 64-bit applications
● Supported configurations

Source Elements © 2005-2022 - ONLINE GUIDE VERSION

http://support.source-elements.com/show/network-guide


○ Any Pro Tools version from 7.0 and up
○ Any VST 3.2 32-bit compatible host
○ Minimum computer requirements: Pentium 4 (or equivalent) 2ghz, 1GB

RAM
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Supported Hosts and DAWs for Source-Live 3.0
Pro Tools

Source-Live Pro 3.0 via the Source-Live Link RTAS and AAX plug-in supports Pro Tools
version 7 or higher, running on the software and hardware configurations required to run
Pro Tools. We strongly recommend running Pro Tools 10.3.5 or higher for AAX support.
There are known issues running RTAS plugins on Pro Tools HD. Please refer to this
document for more information.

VST and Audio Units hosts

See the Source Elements website for up-to-date information on DAW support.
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Network Configuration for Source-Live 3.0
To establish an outside internet link from your computer machine to the world,
Source-Live uses the TCP protocol and modern routers require “Port forwarding” so the
outside world can see the stream on your local computer. When you cannot configure
your network you have the option to use the ‘Source-Stream’ mode if this is enabled for
your account (See the “SourceStream” section).

To configure your local network, detailed configuration guides are here.

Bandwidth

Source-Live requires an Internet connection with bandwidth of at least 300 kbps upload
when in audio only mode, and 1MB upload for video. Your download speed does not
really affect the capabilities of Source-Live. When streaming video, the end-experience
of your client will completely depend on the ability of your CPU to encode, and your
internet connection to smoothly stream. We recommend testing well to ensure your
system is configured for the optimal experience.

You can get an idea of your bandwidth via Internet Speed test sites such as
http://speedtest.net. However, please note that a report from a site in California does not
mean that you will be experiencing the same upload bandwidth when a client in, say,
Australia, is listening to you. If you are having bandwidth issues see the Troubleshooting
sections below.

Firewalls and routers

You may need to configure your firewall and/or router if you are behind a router or have
an active firewall. Corporate firewalls and routers may be able to provide QoS services
to increase your application bandwidth. Please refer to our detailed network-specific
information if you have difficulty connecting successfully.

Source-Live will make application service requests from any available TCP port to ports
443 on our API server (connect.source-elements.com). Most networks allow these
connections by default: if you cannot login, this probably means your network is too
strict to use Source-Live and you should discuss options with your IT department.

To allow remote listeners to view your broadcast audio and video stream, most of you
are behind a router and will need to open at least two TCP ports e.g. 6000 and 6001.

For detailed information on configuring your network, please refer to the Network Guide.
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Installing Source-Live 3.0
Run the installer and follow the instructions. You will be asked to enter your computer’s
Administrator password.

Newer versions of Source-Live will install over older installations. If any issues are
encountered we recommend running the uninstaller first.

If you have 1.3 or earlier installed you may need to manually remove the plug-in file
from your DAW plug-in folder.

InterLok Extensions

You must have the PACE InterLok Extensions installed. InterLok extensions are
installed with the Installer Application. The installer will not overwrite extensions which
are more recent, and will only upgrade older versions.

If you have problems launching Source-Live you may need to manually install the
InterLok Extensions directly from http://ilok.com. Go to ‘Downloads’ and choose the
Driver installer for your system.

Uninstalling

To uninstall Source-Live, run the Uninstall package found in the Installer disk image or
simply drag the Source-Live application to the Trash. You will be asked to enter your
computer’s Administrator password to complete this.

​​
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Quick Start Guide for Source-Live 3.0
Basic steps in using Source-Live are as follows:

1. Launch Source-Live Pro 3.0 from your Applications folder and log in with your
username and password.

2. Optionally place the Source-Live Link on what ever channel in your DAW session
is passing the audio you need to stream. We recommend using your final master
fader channel, or creating an aux and feeding the audio to this channel.

3. In the Source-Live Audio panel->input menu choose Link, or your audio hardware
inputs if you wish to use these directly.

4. Setup your audio session parameters. Parameters that can be set are: Quality
level (e.g. bitrate), sample-rate and channels. Generally you want your
sample-rate to be the same as your DAW.

5. Optionally choose a video source or choose “No video” for an audio-only stream.
If you choose “Screen” as your input you can also crop to the aspect ratio of
16/9. Parameters that can be set are Quality level and Max Frame Rate. You
may also show Mouse Clicks with the Screen option.

6. If you are streaming video and audio from different sources, you will want to set
the correct Audio Delay. This option can be found in the Audio panel and the
parameter is in Milliseconds. See the section Syncing Video and Audio Sources
for more information on this process.

7. Choose your Streaming mode: by default, Source-Live uses your local network
bandwidth for every request. If you cannot configure your router or if you need to
stream to multiple people and do not have enough bandwidth, choose Stream via
server (Source-Stream mode). For more about Source-Stream’s Zero Config
capabilities: http://source-elements.com/source-live/sourcestream

8. Press ‘Start’. Source-Live will initialize and go into broadcast-ready mode. Now
your listeners can go to your Source-Live Gateway and connect to you. All they
need is your Source Live username, and if you have selected to
password-protect your stream you will also need to provide them with the
password entered in the password field.

9. Once your listeners have connected, you can stop streaming at anytime and they
will simply be disconnected. If you restart and your listeners are using the
Source-Live Gateway, it will automatically reconnect them. To disconnect
individual listeners, you can do this by selecting the number listed in the
Listener’s panel and pressing Disconnect. You can recognize listeners by their IP
address and the order in which they log in.
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Using Source-Live 3.0
Logging in

To login, enter your username and password and press the “Log In” button. If your login
is successful, the Status panel will change its view. Otherwise you will get a Login
Failed error: in this case, please visit https://source-elements.com to reset your
password.

To logout, click on the Drop-down menu at the top-right of Source-Live, and select the
Log Out option.

Autologin

With Autologin checked, this allows you to log in automatically upon launching
Source-Live.

Starting a broadcast session

To start broadcasting, press the ‘Start’ button. Source-Live will check its settings and the
status will change to ‘Stop’. The indicator light will blink Red and you can now invite
listeners. If requested, you may also need to run the Port test. This will be required after
first logging in and currently does not happen automatically. If the Port test fails, you can
still invite listeners however unless you are on the same network, it is unlikely that they
will be able to access your stream. You can however use Source-Live for testing
internally, without requiring successful ports. See Section 5.3 for more about the
Network Configuration.

NOTE: Before inviting listeners, it is always recommended that you check your settings.
You can test Source-Live via the Source-Live Gateway website or iOS app.

Inviting Listeners

Once you are broadcasting and ready to accept listeners, you will see a Red blinking
light in the Video panel. Source-Live offers a unique, easy way to invite listeners via a
customizable web interface, the Source-Live Gateway. See Section 10 for more about
the Source-Live Gateway and inviting listeners.

CPU meter

When you Start a broadcast stream, Source-Live monitors the CPU availability and will
alert you if CPU usage is too high. CPU usage issues will affect quality, and your
Listeners may have an unsatisfactory experience. Source-Live will alert at 85% and
100% CPU usage to allow you to improve configuration.
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If CPU issues consistently occur, use the Activity Monitor application (under
Applications/ Utilities) to determine what system resources are being used. You may
expect CPU issues if running a DAW session with many plug-ins and voices that are
also requiring a lot of CPU resources.

Applications such as Google Chrome may require heavy system resources. Try running
SourceLive alone to test what CPU resources you need and shut down any processes
that are not required.

Ending a broadcast session

A Listener can be individually disconnected by pressing the Disconnect button in the
Listeners panel. However, any listener can choose to reconnect. To ensure your next
session is private, change your password and restart broadcasting.

A session is closed automatically if you either quit Source-Live or log out. In the event of
a hardware, software or network failure, you will be disconnected by the server. During
this time your web interface may not register that you are no longer broadcasting. To
expedite this process, logging back in and then logging out will reset the server and web
interface. SourceLive may tell you that there is already a Session being broadcast: you
can safely ignore this if you know an error previously occurred.

Privacy
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Once you have established a connection and are broadcasting audio, you are sending
data directly to your listeners. Network information specific to establishing a connection,
ie. port and IP data, will be available to your listener and are stored permanently in the
Source Elements Database for history reporting and resource analysis.

For a comprehensive outline of our Privacy policy, please read the Privacy Policy.
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An Overview of Settings and Options in Source-Live
3.0
Ultimately the actual capability of your network connection will determine the
consistency of your broadcast and receive reception. However you can optimize the
quality of reception with the Audio and Video quality settings you choose to use.

You can configure the following settings, explained in more detail on the following
pages.

● Audio and Video encoding and stream quality settings. These settings directly
affect both how much bandwidth you will use, and the perceived quality of the
media stream by your Listener.

● Stream title
● Optional authentication and password for stream security
● TCP network ports
● Audio Delay sync when streaming separate audio and video sources

NOTE: You cannot change your settings while broadcasting.

You can also manage Advanced Settings. Generally, you will not need to modify these
unless you wish to allow more users, stream to an external Darwin server, or are
experiencing network problems.

Advanced settings

● Disable UPnP
● Maximum listeners. Defaults to 5

We recommend understanding your network resources as much as possible, as this
allows you to achieve optimal results.
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Quality Settings: Choosing a bitrate for Source-Live
3.0
The higher the bit rate, the higher the quality of the stream. However, higher bit rates
require more resources as they increase the network load. For example, using an audio
bitrate of 64kbps (kilobits per second) will require approximately 20KB (KiloBytes) of
data per second on your actual network, which corresponds to about 200k in required
network speed.

In an ideal world, you should be able to achieve a rate equal to your upload speed
(divided by 8 (to get bytes), less 13% (TCP/IP and general Internet overhead). It is
unlikely you will ever see that speed however, due to issues including network
congestion or overloading on your local network, ISP level, or backbone, and extended
hop counts. Generally, therefore, we recommend a minimum of 300kbps upload to
achieve a reasonable audio stream at 64kbps, and 1MB upload for a video stream at
medium quality and frame-rate. For higher bitrate or frame-rate transfers you will need
more resources - with fiber-optic for example you will find you are able to transfer
multiple streams of HD1024 video!

To check your upload speed see: http://speedtest.net
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Stream Panel in Source-Live 3.0
These settings configure the network options and stream settings.

NOTE: You cannot change these settings while you are broadcasting. To change your
settings you must first stop broadcasting, make your changes, and then start
broadcasting again.

● Title: this is the title that will be displayed on the Source-Live Gateway.
● Password protect the stream: require authentication by your listener for security.
● RTSP port: the port used when your listener is using the RTSP protocol.
● HLS port: the port used when your listener is using the HLS protocol (most

common)
● HLS buffer: modify the stream sensitivity for various types of network

Title

The Title is viewed by your listeners in both the Source-Live Gateway player, and by
media players if launched in a separate window. There is a maximum of 255 characters
for the title. Source- Live supports international characters. You can only change the title
when you are not broadcasting.

Username and Password protection

The optional Username and Password allows you to be sure that you don’t have anyone
listen in without your consent. Without a password, anyone who knows your username
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can connect if you are online and broadcasting. While you can monitor your Listeners
panel, it is often easier to simply require a password. If you do use the password,make
sure you change this regularly or else it will become known. For example, if you have a
number of different clients, you can use a different username for each client to ensure
you don’t have crossover of listeners over various sessions, then regularly change the
password for each of them for security.

Username and Password protection is considered highly secure with Source-Live 3.0.
Each stream has a unique identifier and when authentication is required, a user cannot
re-request the stream once you have restarted broadcasting.

TCP ports: Network Configuration

When connecting to the internet through a firewall or router, at least one TCP port
needs to be enabled for TCP port forwarding (on your router) or for approved access
(on your firewall). This should be a number usually within 1024 - 65534. For allow full
connectivity for all media players, both the RTSP and HLS TCP ports should be opened
in your firewall and/or mapped in your router (where base_port_number is the number
you specify in the Port field in the Settings panel).

Network Summary

Forward 2 TCP ports, for example 6000 and 6001, or 10000 and 10002, to your
computer. If you cannot, use the Source-Stream broadcast option.

HLS Buffer

Most people will want to use the Medium setting. If you are having performance issues,
increase the buffer to High or Highest. Also try lowering your video quality if you are
experiencing consistent buffering issues on the Client side.

For tools and additional resources see:

Configuring your Network

Follow the instructions in the Network Guide.

Router-specific information

This website offers very comprehensive and detailed information on configuring your
router and firewall.

Performance tips

More tips on improving performance can be found here.

Source Elements © 2005-2022 - ONLINE GUIDE VERSION

http://support.source-elements.com/show/network-guide
http://www.portforward.com/routers.htm


Listeners Panel in Source-Live 3.0
When a listener has successfully joined the connection, you will see them listed in the
Listeners panel. Each listener shows:

● Protocol: which method your listener is using: RTSP or HLS. HLS is the most
common.

● Time connected: how long the listener has been connected
● IP Address: the listener’s IP address. If the listener is on the same network this

may be an internal address. Otherwise it will be an external IP address.
● Client: the “Agent” that the client reports itself back to Source-Live as. Common

players are “QuickTime” reported as AppleCoreMedia and a web browser, often
reported as “Mozilla”.

You can disconnect a listener at any time by right-clicking on the line containing that
listener, and clicking on the Disconnect option that pops up.

To permanently disallow someone from connecting, use the Password option in the
Stream panel with a secure password that is regularly updated.

Maximum listeners (Limit number of listeners)

Because you have a finite amount of network bandwidth, we recommend limiting the
number of concurrent listeners allowed to provide the optimal experience to your
existing listeners. The default setting of 5 is suitable for audio streams over cable/DSL
or video streams over high-bandwidth fibre-optic connections.
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The best way to test this setting is through experience. If you need more listeners, try
reducing your Quality Settings.
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Audio Panel in Source-Live 3.0
The audio panel controls the Audio Settings: your input device, sample-rate and quality
levels, and Audio Delay. These settings cannot be changed while broadcasting.

Audio Settings

● Audio Input: the input to Source-Live can be any hardware audio device that is
available to CoreAudio, or the Source-Live Link plug-in from AAX, RTAS, VST or
AudioUnits hosts. If you wish to use a higher sample-rate, ensure that your
device or session file also supports this sample-rate.

● Quality: the Quality option allows you to choose the bitrate of the AAC codec.
See section 4.1 for understanding how your network affects your quality options.

● Sample rate: the input sample-rate of your audio device. Source-Live will
broadcast at 44.1khz or 44.khz, regardless of the audio device sample-rate. E.g.
96khz device audio will be broadcast at 48khz.

● Channels: the input number of channels: one (mono) or two (stereo). You can
choose the specific inputs, if your device has multiple channels.

Audio Delay

This setting is one of the most critical and may require some time and effort to achieve
the desired result.

The aim is to have the video and audio streams in perfect sync with each other, even
though they come from different sources. For example, you may use the ScreenCapture
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method for video and the Source-Live Link method for audio. Or, you may use an HD
video card for video input and audio input from your digital I/O. Regardless, you will
always need to adjust and prepare for the audio delay.

Concepts

● Once the delay is configured for two sources, this delay should be constant
unless other changes are made.

● Delay is affected by factors such as your DAW buffer and processing capabilities.
● Delay is affected by changes in CPU availability. If you have other software

running that requires heavy CPU use this will affect the video capture delay

Configuring the delay

1. Download the Sync test file:
http://source-elements.com/documents/Source-Live-Sync-Test.mp4

2. Load the video in your playback system. For example: we import this as a track in Pro
Tools.

3. Send the audio to Source-Live. In this example we are using the Source-Nexus
plug-in. We could be using the Source-Live Link plug-in, or a digital output. It doesn’t
matter how you send audio to Source-Live, as long as it is a consistent method.
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4. Select the video and audio source in Source-Live. In this example we are using the
Screen method, and Source-Nexus audio for input. We use the Crop button to only
show the video section of the screen.

5. Mute the output of the track in Pro Tools, because we want to only monitor our
broadcast stream.

6. Start the broadcast stream in Source-Live and open the stream to monitor where you
can hear the audio. E.g on another system such as a laptop or iOS device, or on your
main system if you have system monitoring enabled. You will note that the audio and
video are not in sync at first: so we’ll adjust the Audio Delay setting.
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7. Stop the broadcast stream and adjust the Audio Delay setting to an approximate
amount that you think will be accurate. In our example we have put “200” milliseconds.
Now we Start the broadcast stream again and monitor the result. We should be
approaching much better sync.

8. Repeat Step 7 while adjusting the amount of Delay until you are confident that the
Sync is accurate. You may want to write this number down, if this configuration may
change. You can also use a Negative number, if your audio source might have higher
latency than your video source.
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Video Panel in Source-Live 3.0
The video panel is where you can select your video source, or disable video to send an
audio-only stream. Source-Live Pro allows you to select any supported Video input
source, or select an area from the Screen. This may be your primary or
secondary/tertiary screen: Source-Live supports multiple screens.

The video input is fixed at a ratio of 16:9. Any input source will be conformed to this
ratio. The video codec is the widely-used H.264.

Video Settings

● Video Input: the input source to broadcast. If you wish to only broadcast an audio
stream, select “No video”.

● Quality level: the H.264 codec screen resolution. Lower resolution means lower
bitrate and network usage.

● Max frame rate: this is the maximum frame-rate. Note that some players may not
be able to manage full-frame rate, due to network or bandwidth issues.

● Capture mouse clicks: this option is useful if you are doing a remote workshop or
tutorial.

● Crop: if using the Screen input option, you probably want to crop the screen area
to that of just your video window. Select the Crop option and you will be able to
draw the area of the screen to be broadcast. The video screen crop area is fixed
at a 16:9 ratio.

● Reset crop: clears the previously selected crop area.
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The most important setting is the Quality level. Whether your remote listener will get an
excellent stream depends on this setting, and your available bandwidth. The table below
shows approximate bandwidth required, for the broadcaster’s upload and the listener’s
download.

Approximate bandwidth requirement

● 426x240: 0.3mbs
● 640x360: 0.45mbs
● 854x480: 0.7mbs
● 960x540: 0.9mbs
● 1280x720: 1200kbps 1.2mbs

The average home-level DSL connection will have around 300-500kbps upload. A
business-level DSL or Cable connection may have 2mbs upload. Fiber-optic
connections can have more than 100mbs upload.
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Advanced Settings for Source-Live 3.0
Source-Live has additional settings under the Advanced menu:

● Disable UPnP: some routers may give false-positives for UPnP, for example if
you have multiple routers. Disable this to speed up the login process and avoid
false network statuses.

● Always on Top: make the Source-Live application float above all other windows.
Helpful for when you have a single desktop or limited desktop space.

● Autologin: log in on launch using the last-used account
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Source-Live Gateway for Source-Live 3.0
Your listeners have several options to hear your audio:

● Source-Live Gateway via a web browser
● Source-Live Gateway for iPhone and iPad
● Directly in QuickTime Player, VLC or other supported player

Your listener will require at least as much download bandwidth as the Stream quality
settings. Generally we recommend at least 1MB download, however unless this is
dedicated bandwidth they will need significantly more for a stable stream.

4G and LTE networks may support Source-Live streams however note that a HD video
stream WILL CONSUME SIGNIFICANT BANDWIDTH and we do NOT RECOMMEND
that listeners use their 4G or LTE connection except where absolutely necessary.

Once you know you have configured your setup so it meets your requirements (e.g
ports, Audio Delay and Quality settings are valid for your system) and your Listener has
the technical capability to receive a stream, you can invite them in several ways.

Source-Live Gateway via the web

The easiest way to share your stream is via the Source-Live Gateway on any modern
web browser. Supported browsers include Google Chrome, Firefox, Safari, Opera and
Internet Explorer. All browsers except Safari require Flash to be installed.

You can get your Source-Live Gateway link by clicking on the Share button on the
Source-Live center panel and selecting the Weblink option. This will save your weblink
to your Clipboard, so you can paste this into an email conversation or instant message,
for example.

If you have enabled the password option, you will need to provide your listener with this
manually. Using the Source-Live Gateway should be self-explanatory, or follow the Help
Guide instructions that can be found on the Help menu.

Direct connection

If your listener prefers to use a custom player, they can enter your direct URL.

This section describes the URL format and how you can use it to play your stream in
various players.

The Source-Live format has two methods: RTSP (Real Time Streaming Protocol) and
HLS (HTTP Live Streaming). RTSP is becoming less popular and supported, particular
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on Apple computers, so you will find that HLS is the more common format you will work
with.

The basics

You will need to know if your Listener (who may be yourself, for testing), is on your
Network or a remote Network. The easiest way to determine this is to go to
https://source-elements.com/discover from both the Source-Live computer and the
Listener’s computer, and compare IP addresses. If they are the same then you are on
the same Network and you can use the “Internal” examples described here. Otherwise,
use the “External” examples.

1. Find out your Stream ID

Start broadcasting in Source-Live, then select the RTSP or HLS stream under the Share
button. Paste your Clipboard to a text document and note the Stream ID. It will look
something like this:

478F68F5-F8EE-449A-82F5-62DB2C6B46D8

This is a “UUID” type of ID and is considered mathematically unique and statistically
unlikely to reoccur for several billion years. Each time you start streaming you will get a
new Stream ID. So it’s a very secure way to broadcast, knowing that once you stop
streaming, whoever was listening before cannot guess your stream location next time.

2. Find out your streaming IP address

Internal: Your internal IP address, which can be found in your Network Settings. An
Internal address will look like one of these examples:

● 192.168.x.x
● 10.x.x.x
● 172.x.x.x External:

Visit https://source-elements.com/support/discover and note your IP address.

3. Format the Stream Resource

Once you have the Source-Live computer’s internal IP address you can format the
resource where you stream can be found.

The RTSP URL is formatted as follows:

RTSP://[IP_ADDRESS]:[RTSP_PORT]/[STREAM_ID]

The HLS URL is formatted as follows:
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HTTP://[IP_ADDRESS]:[HLS_PORT]/[STREAM_ID]

For example, on a computer with IP address 192.168.1.23, and default port, the URL
will be:

rtsp://192.168.1.2:6000/STREAM_ID and http://192.168.1.2:6001/STREAM_ID

The resources can be accessed via the external IP:

rtsp://12.34.56.78:6000/STREAM_ID and http://12.34.56.78:6001/STREAM_ID

4. Open the Resource with your Player

How you open a Resource depends on your Player. Some examples follow.

QuickTime Player X

File->Open Location (⌘-L) and paste in the HLS Resource

VLC

File->Open Network (⌘-N) and paste in the RTSP or HLS Resource

Source-Live Gateway for iOS

Download the free iPhone and iPad app from iTunes, found from this link.

Simply enter the username you are broadcasting with (with optional authentication), and
you’ll hear the audio.
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Source-Live 3.0: Best Practices

Know your listener's bandwidth

When using real-time streaming of high-quality audio over the Internet you may need to
make some adjustments to get the best results for your Listeners. Follow these
instructions to know what mode to use before you start your sessions.

Ask your listener to test

Choose the location nearest to where you are streaming from and ask your Listener to
test and tell you the results for "Download speed" and "Ping" time. (Ping may not be
available on all servers). If they are getting less than 300kbps (0.3Mb) download,
consistently, then Source-Live is probably not going to work well.

Various worldwide:

● United States
● United Kingdom
● Northern Europe
● Singapore
● Australia

Once you have this information you can better decide on which mode to use.

'My Network' for lower latency (User-selected in Source-Live 2.0, default mode in
Source-Live 3.0)

To achieve 1-3 seconds of latency when streaming from one location to another, this
requires that you have low 'server' and 'stream' buffer settings on the Source-Live
settings pane. The downside to low latency is that the stream may drop if there is a
large distance between you and your Listener, or they have inadequate bandwidth.

To improve stream stability, you can increase the 'server' and 'stream' buffer values.
This will increase latency but it does allow your Listener to hear your entire stream
without dropping the signal.

Note: "My Network" mode requires that you have port forwarding enabled.

'Source-Stream' for Stability ('Stream Via Server' checkbox in Source-Live 3.0)

In even less-than-ideal cases you may need to use Source-Stream mode. This is the
safest mode and is suitable for any broadband connection, even low bandwidth options.
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The latency is increased up to 8-12 seconds however this is still lower than most other
streaming methods, plus with Source-Live you get the superior quality of AAC encoding
at high bit-rates.

If you're not sure, start with Source-Stream mode. Or you can ask your Listener to test
the Preview stream before you start working together: this stream uses the same
method as "Source-Stream" mode. If your Listener cannot successfully hear the
Preview stream then it is unlikely that Source-Live is a suitable method of collaboration
for you while in your respective locations.

Another reason to use Source-Stream mode is if you are in a location where port
forwarding is unavailable - work from your hotel, airport, beach - wherever!

Summary

Ask your Listener to test the Preview stream before you work together. Find the Preview
stream here. If you want to use low-latency "My Network" mode ask your Listener to do
a Speed test. When in doubt, increase your 'server' and 'stream' buffer. You can lower
these buffers when using Source-Stream mode if you yourself have strong internet.

Tips

Using Skype/video chat, downloading or uploading large files can all affect the quality of
the connection. If your Listener is on WiFi and the signal is weak, ask if they can get
closer to the source of the signal for a better connection. Try our free iPhone app - 4G
and LTE connections can work extremely well. You'll need to be in "My Network" mode
for this.
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Technical Support for Source-Live 3.0
Below are some of the most common scenarios faced by our users.

Automatically disconnected, ‘Connection reset by peer’ dialogue

There may be severe network congestion occurring. This can happen if you are inside a
LAN where many other users are downloading and uploading large files. Reduce your
bitrate, increase the buffer size and reconnect.

DAW CPU or H/W buffer errors

On less powerful computers it is important to note that Source-Live requires a large
portion of processing power, so you should not run any unnecessary applications or
services. You should also limit the instances of any other plug-ins not required for your
Source-Live session.

Interrupted audio on Listener end, many artifacts.

Try to reduce your bitrate and increase the buffer sizes in the Advanced Settings panel.
You may also be experiencing hardware issues: for example, if you are clocking your
system with an external clock, check that your hardware clock matches your session
sample rate.

Latency Expectations

When using Source-Live 3.0, there is some expected latency depending on the mode
you are using: 2-3 second (low latency mode) and 10 seconds (stable mode).

Spacebar opening up the Source-Live Gateway

Source-Live opens the Source-Live Gateway when the space bar is opened. This can
be fixed by turning off the "Use keyboard navigation to move focus between controls" in
System Preferences > Keyboard > Shortcuts.
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Reporting Issues

Technical Support is available via email, telephone and via Source-Connect. To report
an issue, please provide the following information:

1. Source-Live build number (available from the About box).
2. System configuration (Operating system, computer hardware).
3. DAW type and version and hardware.
4. Network configuration ie. LAN, DSL, wireless etc.
5. Source-Live settings: username, quality settings, port status.
6. Bandwidth report, for example from http://speedtest.net
7. Description of what action(s) you were taking when the issue occurred, for

example who you were connected to and what their settings were.

About Box

The About Box provides information on which version of Source-Live you have installed.
This information is important when speaking with our Support team to resolve issues. To
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view the About box, click on the Source Elements logo at the top of the Source-Live
window. You can close the About box by clicking anywhere in that box.

Contact us

Contact Source Elements for technical and general support:

● Forum: the main source of support and technical information is the online forum.
Please visit the forum before contacting us to see if your question has been
answered: http://www.source-elements.com/forum

● Email: send an e-mail to technical support: support@source-mail.com
● Telephone: See our numbers here: http://source-elements.com/contact
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